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About this Manual 

Who’s this for? 

This manual is intended for the operator of the HES1000 spectrometer (BlackFly 
version).  It will allow the operator to understand how to get the most out of this new 
product. 

What’s in it? 

This manual provides the operator with instructions on how to use the HES1000 
software package included with your spectrometer. 

A separate manual is available that describes how to unpack, install, calibrate and use 
the HES1000 spectrometer.  This is included on the USB stick provided, along with the 
most recent version of this manual. 

Introduction Contains an overview of the HES spectrometer 
and the methodology of how to use it 

Installation Instructions on how to install the software 

Start the GUI How to get the software up and running 

Operating your HES1000 software Details of how the software is operated using 
the menus and button commands 

Acquiring Data Details on the process you should follow to 
acquire data 

Data Display Explains the various ways you can view your 
data, in both real time and historic saved files 

Appendix A: Troubleshooting Gives some suggestions on what to try if you 
have a problem 

Appendix B: Calibration Takes you through the process of 
recalibrating. 

Appendix C: Apodisation Explains some of the apodisation techniques 
available in the software 

Appendix D: File Format Shows you how your data file is made up 

 

Warranty 

All ISI’s products come with a 1-year warranty covering parts, labour and shipping 
needed to repair manufacturing defects that occur during the warranty period.  
Shipping costs are limited to shipping to and from our customers during the warranty 
period.  The warranty will be void if the system is handled inappropriately or if the 
housing has been opened. 
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Disclaimer 

THE INFORMATION CONTAINED HEREIN IS PROVIDED "AS IS" WITHOUT WARRANTY, 
CONDITION OR REPRESENTATION OF ANY KIND, EITHER EXPRESS, IMPLIED, 
STATUTORY OR OTHERWISE, INCLUDING BUT NOT LIMITED TO, ANY WARRANTY OF 
MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. 

IN NO EVENT SHALL IS-INSTRUMENTS BE LIABLE FOR ANY LOSS OR DAMAGE, 
WHETHER DIRECT, INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR OTHERWISE 
HOWSOEVER CAUSED WHETHER ARISING IN CONTRACT TORT OR OTHERWISE, 
ARISING OUT OF OR IN CONNECTION WITH THE USE OF THE INFORMATION PROVIDED 
HEREIN. 

COPYRIGHT AND PROTECTIVE NOTICES: 
The copyright in this document and the associated drawings are the property of IS-
Instruments Ltd. and all rights are reserved. This document and the associated 
drawings are issued on condition that they are not copied, reprinted or reproduced, 
nor their contents disclosed.  The publication of information in this documentation 
does not imply freedom from any patent or proprietary right of IS-Instruments or any 
third party. 

TRADEMARKS & PATENT INFORMATION 
IS-Instruments, and the ISI logo are trademarks of IS-instruments Ltd. FLIR, the FLIR 
logo and BlackFly are trademarks of FLIR Systems. 
All other marks are property of their owners. 
Changes are periodically made to the product and these will be incorporated into 
new additions of the manual.
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1. Introduction 

1.1. What’s the product? 

The HES1000 spectrometer is a Static Fourier Transform spectrometer providing high 
etendue measurements.  Etendue is commonly referred to as throughput of a 
spectrometer.  It is a measure of the ability of a spectrometer to capture and utilise 
individual photons from a particular area of a target or field of view.  A more complete 
description of this can be found on our website – It’s all about throughput. 

Some of the key features are detailed below: 

Model HES1000 HES1000B HES2000 

Operating 
range < 200 – 2400 cm-1 < 230 – 1800 cm-1 < 200 – 2300 cm-1 

Resolution* ~ 3 cm-1 per Fourier bin  
~1.5 cm-1 per 
Fourier bin 

<3 cm-1 per Fourier bin 

Fibre coupled SMA or FC/PC SMA SMA or FC/PC 

Fibre aperture <1 mm as standard 910 µm ≥1 mm as standard 

Fibre NA 0.22 0.22 0.22 

*Unlike most other systems, the HES spectrometers are linear in wavenumber space, meaning you 
won’t lose resolution as you move from the starting wavelength. Unlike conventional spectrometers 
there is no slit present so no blurring is observed. (A minimum of 3 bins are required to resolve 2 lines)   

1.2. System requirements 

To run the system software, you will need a compatible device, running Windows 7 or 
later. 

The compatible device will need a USB3.0 port and approximately 350 MB disk space.  
Performance requirements are minimal - a 2GHz single core processor and 1GB RAM 
will be sufficient.  

2. Installing Software 

The software may be included as a USB stick or as a direct download from our website.  
You will need to run the ‘setup.exe’ file located in the ‘HES1000 Installer\Volume’ 
directory.  This will start the installation routine.  You may receive a ‘This file is from 
an untrusted source.  Do you want to run it?’ message.  Click ‘Yes’ to continue. 

You should then see the following screen: 

http://www.is-instruments.com/assets/its_all_about_throughput.pdf
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After the installer initializes you will be prompted for the installation location. We 
recommend using the default options. 

 

Click ‘Next’ twice (you may need to select whether to disable Windows Fast startup – 
we have not experienced problems with this so uncheck it, but this may be platform 
specific). 
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You will then get the progress bar showing you how much remains 

 

Followed by the ‘Installation complete’ display.   

 

Click ‘Finish’ to complete. 
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Next, another installer will launch to install the FLIR/PointGrey BlackFly USB drivers. 

 

Click ‘Install’ 

 

Click ‘Next’ 
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Agree to the terms to proceed. 

 

Click ‘Next’ when you are ready to proceed. 
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Registering is optional and at the discretion of the user. If you do not wish to register, 
untick the ‘Automatically register…’ option before clicking ‘Next’. 
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Select the installation location before clicking ‘Next’. 

 

Select ‘Complete’ before proceeding. 
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Select ‘I will use USB cameras’ before proceeding. 

 

Click to confirm before proceeding. 
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Click to register the dlls before proceeding. 

 

Click ‘Install’ to begin. 
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If you wish to view the help files this is a good opportunity, otherwise click  to finish. 

Your software should now be ready to go, but we advise restarting your machine first 
to ensure the correct files are registered on your computer. 

Shortcuts should be provided for you to run your software, but if this has not occurred 
due to local settings on your machine, then the HES1000.exe file can be found in the 
‘Program Files(x86)’ directory. 

The ‘Operators Guide’ provides full instructions on how to install your hardware. 
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3. Start the GUI 

To start the HES1000 GUI click on the desktop icon or select 'Programs' via the START 
button in the Windows task bar and navigate to 'All Programs / ISI HES1000' (or under 
ISI HES1000 in Windows 10 from the Windows button). 

This should open the main window GUI, as shown below in  

.   

 
Figure 1 Starting view of GUI 

On first use a dialog box will appear asking for a ‘Data Save Location’. This is the file 
path to the location where any files saved automatically. The software will create a 
directory with today’s date to store the files.  Note that when ‘Save As’ options are 
used, the files will be saved in a location of the user’s choosing.   

Afterwards a camera selection window will open (Figure 2). 
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Figure 2 Camera Selection window 

All the compatible cameras (FLIR/Point Grey) will be displayed in this window.  Shown 
above is the correct model (Blackfly BFLY-U3050H5M). Ensure this is highlighted and 
click ‘Configure Selected’. This will open another window that contains all the settings 
for the camera.  This configuration window can also be opened from the main GUI to 
adjust the camera settings during operation. Details of how this can be used to 
configure your camera can be found in section 4.2. For now, it is best to go to the 
‘Custom Video Modes’ tab and make the following changes: 

• Pixel Format: Mono 16 

• Image: Left – 0, Top – 975, Width – 2448, Height – 400 

Click on ‘Apply’ and close the window. This returns you to the camera selection 
window (Figure 2). Click on ‘OK’ to proceed. 

The software will then try to detect if your HES1000 is present.  Please note that each 
installation contains calibration data for the HES1000 it was supplied with.  Contact ISI 
if you wish to use more than one HES1000 on a single local machine. 

If the software fails to detect a HES1000 a window appears saying “Error 3”. You 
should click on ‘continue’ and then the following error message will appear: 

 

If you are happy to proceed in ‘Data Only’ mode, then click ‘OK’ and begin investigating 
the files you have already saved.  The HES1000 GUI provides this additional feature in 
that it can be used as a data viewing tool without needing the spectrometer to be 
present.  It also allows basic data analysis techniques to be performed.  The operation 
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of the software is identical to when a spectrometer is present, but with some 
functionality removed. Details of how to use this mode can be found in section 5.2.  

If you were expecting the spectrometer to be detected then you should quit the 
software (section 7), check the USB connections, confirm the FlyCapture camera driver 
has been installed and restart the software.  If the problem persists, please contact IS-
Instruments Ltd. 

With a HES1000 connected the GUI will appear slightly differently, with more controls 
enabled and some new ones appearing (Figure 3). 

 
Figure 3 The GUI with a HES1000 connected 

In this mode, the software will allow you to fully drive your HES1000 and provide the 
same functionality as the data only mode. 
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4. Operating your HES1000 software 

With the GUI up and running your HES1000 will be just about ready for use.   

4.1. Main Window Commands 

The main window is your interface to your spectrometer.  The various commands that 
you can use can be accessed via the menu bar, or by using some of the shortcut 
buttons provided.  Some of these will only be available under certain conditions and 
may be disabled or completely disappear.  Some of the commands are only available 
by clicking on the buttons, such as the ‘Autoscaling’ and ‘Zoom Pop’ commands. The 
various commands on each menu will be described below. 

4.1.1. ‘File’ Menu 

Command Button Description 

Open Spectrum 
 

Opens a previously saved spectrum  

Open Image file - Opens a previously saved image file  

Open Dark Image - Opens a previously saved dark image file  

Overlay Spectrum - Opens a previously saved file and overlays it 
on the current display 

Store Reference 
Spectrum 

 
Stores the last acquired spectrum to a 
temporary storage location 

Subtract Reference 
Spectrum 

- Subtracts the stored reference spectrum 
from the current display 

Overlay Reference 
Spectrum 

- Overlays the stored reference spectrum on 
the current display 

Delete Last Spectrum - Removes the last overlaid spectrum from 
the current display 

Save 
 

Saves last acquired intensity spectrum 
(.spec), power spectrum (.pspec) and raw 
image (.hes) image automatically to the 
selected data directory 

Save As… - Saves the last acquired spectra & image (as 
above) to a user selected name and location 

Save Dark Image  Saves the last acquired image as a dark 
image for future use & stores as dark frame 

Record 
 

Continuously saves the spectra (only) to the 
selected data directory 

Data Location 
 

Allows the user to adjust the location in 
which the data are automatically saved 
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File info - Displays the file header information for the 
last opened data file 

Quit 
 

Shuts down the HES and closes the software 

 

4.1.2. ‘Edit’ Menu 

Command Button Description 

Undo - Standard Windows operation 

Redo - Standard Windows operation 

Cut - Standard Windows operation 

Copy - Standard Windows operation 

Paste - Standard Windows operation 

 

4.1.3. ‘Acquire’ Menu 

Command Button Description 

Start 
 

Start to continually acquire spectra 

Stop 
 

Stop acquiring spectra 

Snapshot 
 

Acquires a single spectrum 

Camera Settings 
 

See section 4.2 

Save image - Continually save the raw image also if 
‘Record’ is in use (advanced use only).  
Select to toggle on/off. 

Dark Frame - Allows use of dark frames that are a 
common tool used to remove unwanted 
background/contaminants 

Dark Frame > Store 
 

Store a dark frame for background 
removal 

Dark Frame > Apply 
 

Subtract the dark spectrum from the 
current display 

Apodise > [options] 
 

Apply selected apodisation – see Appendix 
C 

 

4.1.4. ‘View Menu 

Command Button Description 
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X-Axis - Allows you to set the x-axis 

X-Axis>Wavelength  Set the spectra to be displayed in 
wavelength (nm). Click on arrow to switch 
to Wavenumber. 

X-Axis>Wavenumber  Set the spectra to be displayed in 
wavenumber (cm-1). Click on arrow to 
switch to Wavelength. 

Y-Axis - Allows user to set the y-axis 

Y-Axis>Power Spectrum - Displays the power spectrum (default) 

Y-Axis>Intensity 
Spectrum 

- Displays the intensity spectrum 

Autoscale 
 

Autoscales the spectrum display area 
(default is ‘ON’) 

Zoom Pop 
 

Stops the acquisition and ‘pops’ a window 
out to allow you to zoom in to the 
spectrum.  See section 6.1.1. 

Display - Allows you to view the data in different 
states of analysis 

Display>Spectrum - The default mode.  This displays the 
output spectrum 

Display>Raw Image - Displays the output of the camera, an 
interferogram. 

Display>FFT - Displays the output of a 2D FFT on the 
interferogram 
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4.1.5. ‘Analyse’ Menu 

Command Button Description 

Averaging - Allows you to apply averaging to the data 
in real time 

Averaging>None 
 

No averaging is applied 

Averaging>Add 
 

Add a set number of acquisitions together 
to produce a single spectrum 

Averaging>Running 
Mean 

 
Applies a running mean to consecutive 
spectra (also known as a rolling mean or 
moving average) 

Averaging>Block Mean 
 

Applies a block mean to the data (a set 
number of acquisitions are used to create 
a single result before starting a new 
block).  

Averaging>Median 
 

Applies a Median filter to the 
interferograms. Helps to remove transient 
events. 

Averaging>Size - Allows you to set the number of 
acquisitions to be used in the ADD/MEAN 

Median Filtering - Median filter the spectra in real time 

Median Filtering>None - Remove Median spectral filtering 

Median Filtering> 
Interferogram 

- Apply median filtering to an interferogram 

Median Filtering> 
Spectrum 

- Apply median filtering to the spectra 

Median Filtering>Rank - The amount of median filtering.  A low 
rank is a small amount of filtering 
(0=none) 
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4.1.6. ‘Tools’ Menu 

Command Button Description 

Peaks - Allows you to automatically locate and 
label the peaks in your spectra 

Peaks>Locate - A submenu for configuring the peak 
detection algorithm 

Peaks>Locate>Threshold  Only peaks with heights above this level 
will be detected and labelled 

Peaks>Locate>Width  The FWHM of the peaks to be detected 

Peaks>Display 
 

Displays the location or height of the 
peaks detected in your spectra 

Peaks>Display>Location - Display the location of the peaks in 
wavelength/wavenumber 

Peaks>Display>Height - Display the height of the peaks 

Calibrate - Allows you to adjust the calibration of 
your HES1000 (advanced use only) 

Calibrate>Adjust Coeffs - Prompts you to enter the new coefficients 

Calibrate>View current - Only peaks with heights above this level 
will be detected and labelled 

 

4.1.7. ‘Help’ Menu 

Command Button Description 

Instrument Setup - Displays the spectrometer’s setup 
characteristics in a dialog box 

About - Displays details about the software 
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4.2. Camera Settings 

For the Blackfly camera, the manufacturer’s configuration tool (Figure 4) had to be 
incorporated into the control software due to limitations in compatibility.   

 
Figure 4 Manufacturer’s camera configuration tool 

This control window provides many features that are either unnecessary or 
detrimental to the operation of the camera inside the HES spectrometer. These 
controls have been turned off programmatically. These are Brightness and Exposure. 
If you accidentally switch them back on, they will be turned off automatically. 

Sharpness, Gamma and Gain can provide useful enhancement of the data for signal to 
noise improvements but can introduce unwanted errors.  FrameRate control has also 
been switched off as this can limit the measurement lengths available.  

These features have been left enabled but can be adjusted by the user. Sharpness will 
be on and set to its maximum by default, Gamma, Gain and FrameRate will be 
switched off by default. 

A full description of this and the camera selection tool can be found under FlyCapture 
SDK Help, which should be found in the START menu under ‘Point Grey FlyCapture2 
SDK>Documentation’. The main controls that should be used will be described below.  
Any other controls may affect the performance of the system and will not be 
documented.  If the system becomes unstable, quit the software, unplug the camera 
from the PC, wait ~ 6s, replug the camera into the PC and restart the software.  This 
should reset the camera to its default settings. 
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4.2.1. Camera Settings 

The camera settings tab is the one which will be used most commonly. Full 
explanations of each control can be found in the SDK help, but the key controls here 
are: 

Shutter: Length of the measurement in milliseconds 

Please note that adjustments on this tab take effect immediately, so care should be 
taken to avoid overexposure or prolonged unwanted measurements. 

The system does, however, suffer some measurement lag. Usually, two images are 
acquired with the old settings, prior to the changes being made.  For example, when 
the shutter is changed from 1 ms to 100 ms, 2 x 1ms images will be acquired and 
displayed, prior to the 100 ms images being available. 

4.2.2. Custom Video Modes 

This tab should be used initially to set up the camera, but not adjusted routinely. The 
key controls are described below: 

Command Button Description 

Mode 
 

Enables the binning modes of the camera. 
Use of this feature is not recommended so 
Mode 0 should be selected. 

Pixel Format 
 

Allows the user to select the ADC bit depth 
of the camera.  Due to compatibility 
limitations only Mono 8 & Mono 16 are 
recommended.  Mono 16 will provide the 
best sensitivity. 

Image 

 

Allows the user to select a region of 
interest. The camera will only acquire data 
in the selected area, which can help 
reduce the influence of read noise as the 
data are only captured in a narrow 
letterbox on the detector. At manufacture 
the settings were: 

Left = 0           Width = 2448 

Top = 975      Height = 400 

User adjustment away from these values 
may limit performance or improve it. 

 

The other controls should not be adjusted. 

Adjustments to these controls only take effect once the ‘Apply’ button is clicked. 
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4.2.3. Updates 

Whilst updates may become available for this camera driver, it is advised not to update 
without first contacting ISI, as the updated driver may be incompatible with your HES 
software. 

4.3. Other controls 

Whilst most of the controls have been covered in the previous section, a few have not 
been discussed as they do not have menu-based commands. 

 

Text (e.g. experiment details) can be entered 
here that will be included in any data file that is 
saved. 

 
If your software gets stuck, which can happen 
from time to time with USB devices, clicking on 
this can sometimes clear the problem. See 
Appendix A for help with troubleshooting. 

There are also some indicators that provide useful information. 

 

This will display the file path of either the last saved file or of the last opened file, 
depending on what you are doing at the time. 

 

This will provide information on what is happening with your system at the moment. 

 
This gives you an indication of how many photons are 
being detected.  In 2D mode it is the mean number of 
counts seen over the pixels of the camera (1600 x 1200 
for IDS UI3250).  . 

 This indicates if the camera is possibly being over 
exposed.  If so it will turn red and you should reduce 
either the exposure time or the amount of incident light 
immediately.  Therefore, you should always start with a 
very low exposure (e.g. 1 ms) and slowly increase 

 
Shows the current exposure time 

 Progress bar for current exposure 
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5. Acquiring Data 

In order to acquire data successfully you should follow the guidelines detailed in the 
Operators Guide for the setup of your hardware before starting the software. 

5.1. The Process 

To acquire data the following sequence should be followed: 

• Prepare hardware setup 

• Ensure the HES1000 is powered 

• Start the software 

• Set Exposure to a small value (e.g. 1 ms) to ensure no overexposure 

• Start the acquisition 

• If the light levels are ok gradually increase exposure time to desired level 

• Stop acquisition 

• Adjust other settings to suit (e.g. averaging, filtering, save notes, etc.) 

• Start acquisition 

It is often beneficial to take a ‘Dark Frame’ to improve signal to noise.  To do this 
ensure no light can enter the system (also remove fibre).  Use a long exposure, e.g. 
10 s, in the mode you wish to operate.  When it has finished click on the ‘Store Dark’ 
button and then continue with your acquisitions.  You can apply the dark frame 
subtraction by clicking on the ‘Subtract Dark’ button.  The software automatically 
calculates the dark ratio to remove based on exposure time.  It is imperative that the 
image size (set by AOI) is the same for both Dark images and measurement. 

Once you have finished your data collection you can view the files in this package, but 
you may wish to shut down the system first and use it in ‘Data Only’ mode (section 
5.2).  The correct procedure to safely shut down your system is simply to make sure 
you click on the ‘QUIT’ button and wait for the software to stop switching off the 
power or removing the USB cable. 

5.2.  ‘Data Only’ mode 

As described earlier your software can be used as a file viewer for previously saved 
data.  If your software is operating in this mode, then the main window will appear as 
shown in  

 with the acquisition-based controls being disabled. 

To view a data file either use one of the ‘File>Open…’ menu commands or click on the 
open file button (section 4.1.1).  Navigate to the desired .spec, .pspec or .hes file and 
select it.  You will have the ability to perform some basic analysis on this file and adjust 
the viewing options.  See Appendix D for information on the file formats. 
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6. Data Display 

Once the data have been acquired there are several options for displaying it.  There 
are three types of data display, each with their own way of navigating and adjusting 
the display.  These are accessed via the View>Display menu. 

6.1. Spectrum 

This is the default mode that the software will always start in.  It displays the spectrum 
that has been calculated from the raw image collected by the HES1000 camera.  An 
example of a spectrum is shown in Figure 5. It should be noted that by default the data 
is apodised to improve the quality of the spectrum gathered. 

 
Figure 5 A paracetamol transmission Raman intensity spectrum taken by a HES1000 (1mm aperture 30s exposure 
without dark image subtracted). 

In this display the Y-axis is a relative intensity or contrast. These values can be used to 
estimate the number of photons at a particular wavelength by multiplying by the 
number of pixels: 5 MPix for the full frame but reduced if ROI is used.  This can be set 
as either the power spectrum, typical of Fourier Transform Spectrometers, or the 
intensity spectrum, typical of traditional dispersive spectrometers, by using the menu 
command (section 4.1.4). The system defaults to power spectral display. 

The x-axis can be adjusted between wavelength (nm) and wavenumber (cm-1) using 
either the menu command or button (section 4.1.4).  The x-axis will then display the 
spectrum in the desired units. 

By default, the display will have the ‘Autoscale’ option selected.  This is designed to 
best display the data without the need for adjusting scales by hand, but sometimes it 
may not produce the best display.  If this is the case, then switch it off by clicking on 
the button  and begin manual adjustment.  This can be done in several ways.   

The first is to click on the start and/or end values on the scales and manually edit the 
values as required.  The most efficient way is often to use the navigation tools at the 

bottom left of the display . These are described below. 
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 Not used 

 Clicking on this provides several useful navigation options that allow you to 
zoom in/out in different manners.  These are a window zoom, an x- and y-
axis zoom, a zoom in and a zoom out. A reset option is also provided.  

 Clicking on this allows you to move the data around inside the display by 
clicking and holding in the display area and moving the mouse around. 

Another useful tool when viewing the data in this mode is the peak detection (section 
4.1.6). This allows you to label the peaks in your data.  Clicking on the peak detection 
button will label the peaks using the default settings.  This may not be suitable for your 
data and the threshold and width may need adjusting.  Typically adjusting the 
threshold level to be just above the noise level will provide the best results.  The type 
of label can also be adjusted between location in the chosen x-axis and height (y-axis).  
An example of this is shown below in Figure 6. 

 
Figure 6 The paracetamol spectrum with some of the peaks labelled 

The final display tool is the Zoom Pop. 

6.1.1. Zoom Pop 

This is a feature designed by us following discussions with some users about what they 
wanted to see in their software.  The ‘Zoom Pop’ will stop the acquisition if it is in 
progress and will open a new display, as shown below in Figure 7.  The spectrum is still 
displayed but in a slightly smaller window.  On the right, a small window appears that 
will display sections of the spectrum in more detail.   
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Figure 7 The Zoom Pop display  

The size of this zoomed area can be adjusted using the provided control and the 
location is controlled by moving the mouse pointer across the spectrum in the larger 
window.  This display autoscales to the data.  To return to the standard mode simply 
click on the button once more.  

6.2. Raw Image 

This mode displays the raw data collected by the camera and is not designed for 
everyday use.  These data are an interferogram.  However, all cameras have intrinsic 
noise and one of the main contributors is read noise, potentially reducing the SNR.  
This can be optimised by using the AOI, which can be set in the ‘Acquire’ menu. This 
allows the user to specify the region in which the data are being collected and not 
process extraneous data, potentially adding extra noise.  An example of an apodised 
interferogram is provided in Figure 8. 

 
Figure 8  Interferogram (produced by HES2000) 
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As with the spectrum navigation, the axis values can be manually adjusted by clicking 
on the values and editing.  Similarly, the navigation tools at the bottom left of the 
display can be used in the same manner.  The only main difference is the inclusion of 
an intensity scale on the right of the display.  This provides the colour ramp for the 
data and can be adjusted in the same manner as the x- and y-axes.  However, it is set 
by default to autoscale so if you wish to adjust the values you will first have to switch 
off the autoscaling on this colour ramp.  This is done by right-clicking on the colour 
ramp and unchecking the ‘Autoscale’ option.  You can now manually edit the top and 
bottom values. 

6.3. FFT 

This option displays the results of a 2D Fast Fourier Transform (FFT) on the 
interferogram in pixel space.  Figure 9 shows an example of this display. 

 
Figure 9 FFT of the above 2D interferogram  

This display is navigated in the same manner as the raw image, but the colour ramp is 
not autoscaled.  The reason for this is that the central peak values of the FFT are 
extremely high compared with the interesting data.  Therefore, the display will load 
with nominal values that often produce a good display, but this will depend heavily on 
your SNR and incident light levels.  Typical maximum values range from 100’s for very 
high signals, down to 1E-5 for weak signals. 

7. All done 

That’s it.  We hope your HES1000 performs as you hope and delivers the capability 
you require. If you have any problems, we’ll be happy to help. 
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Appendix A: Troubleshooting 

If you follow the instructions provided you should not experience any problems.  
However, should a problem occur please check out this section for advice on how to 
fix it.  If nothing in here helps, then please contact us and we’ll try to resolve the 
problem as quickly as possible. 

Problem: When I run the software the ‘Run’ button is disabled  

Cause 1: Spectrometer connected before installing software 

Solution: Remove the Unknown Device from Windows Device Manager 

1. Open Windows Device Manager. This is done through the Control Panel.  If you 
are unsure how to get to this check out the Windows help. 

2. Locate the Other Devices option and expand the Other Devices selection by 
clicking on the "+" sign to the immediate left. 

3. Locate the unknown device (marked with a large question mark). Right-click on 
the Unknown Device listing and select the Uninstall or Remove option. 

4. Click the OK button to continue. A warning box appears confirming the removal 
of the Unknown Device. Click the OK button to confirm the device removal. 

5. Disconnect the HES spectrometer USB cable connecting from your computer. 
6. Uninstall the software (if you have already installed it) 
7. Reinstall the software 

Cause 2: The software has not recognized the HES is connected 

Solution: Confirm the HES spectrometer is connected by the USB cable 

Cause 3: The USB port has become ‘jammed’ 

Solution: USB ports frequently become jammed if devices are plugged/unplugged 
frequently or software crashes.  The easiest way to solve this is to reboot the PC but 
often closing the software, unplugging then reinserting the USB cable and then 
restarting the software will do the job. 

 

Problem: When I run the software, it can’t find HES1000.ini and stops 
working 

Cause: The file has either not been installed properly, moved or corrupted 

Solution: Copy the file from the installation stick/location into the installed directory 
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Appendix B: Calibration 

Though your HES spectrometer is calibrated at ISI, like all spectrometers this 
calibration can drift over time due to several reasons, such as environmental 
conditions.   

As the HES spectrometer is based around diffraction gratings the only coefficient likely 
to ever need changing (assuming correct use) is the Littrow Wavelength.  This is the 
wavelength of incident light that will be reflected straight back.   

If you feel that the calibration has drifted, then you can adjust this by clicking on the 
‘Tools>Calibrate>Adjust Coeffs’ menu item.  Any changes you make cannot be undone, 
so please make notes of previous calibration coefficients in case of a problem.  This 
will be saved into the configuration file and used going forward.  If this file becomes 
corrupt it be reloaded from the installation stick or a copy requested from ISI (info@is-
instruments.com). 

It should be noted that if the instrument is to be used for Raman measurements the 
Littrow wavelength of the spectrometer and the Raman laser wavelength will need to 
be entered. 

If your system is fitted with an alignment option (detailed in the operator guide) then 
adjustment of this will require an update of the calibration coefficients.  This is most 
likely to affect the Littrow wavelength (the wavelength at which the Littrow condition 
applies for each grating). 

The value for the Littrow wavelength can be determined either by trial and error 
adjustment to match known calibration peaks, or by plotting the position of the known 
calibration peaks from an output spectrum (in pixel space) against the expected 
wavenumber.  For example, if a paracetamol spectrum were used… 
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Pixel Peak Expected Wavenumber (cm-1) 

128 326 

151 389 

255 650 

312 795 

337 857 

521 1323 

650 1647 

 
Now plot the Pixel peaks vs expected wavenumber and use a linear fit to determine 
the gradient and intercept: 
 

 
 
The gradient (2.53 in the example above) is the wavenumber resolution obtained by 
the system per pixel.  The intercept (5.4 in the example above) is the Littrow 
wavelength (λL) expressed as a Raman shift (Δw in cm-1) from the excitation 
wavelength (λ0). 
 

∆𝑤 =  (
1

λ0
−

1

λ𝐿
) 

So… 

λ𝐿 =
1

(
1
λ0

− ∆𝑤)
 

Therefore, in the example above: 
  

λ𝐿 = 785.31 𝑛𝑚 
 
This can then be entered as the new Littrow wavelength in the calibration coefficients.  
The other coefficient should not be adjusted without first consulting IS-Instruments.  
 

y = 2.5273x + 5.3884
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Appendix C: Apodisation 

Apodisation is a technique to apply a window function to an image.  This sets all values 
to zero outside this window area.  It is commonly used to improve data quality and 
suppress noise effects, especially in Fourier transform spectrometers.  By default, 
apodisation is enabled in this software using a Hanning window.  Several window 
functions are available.  Some are described below. 

Hanning (Hann) Window 

If y represents the output sequence Windowed X, the Hanning Window obtains the 
elements of y using 

yi = 0.5xi[1 − cos w] 

for i = 0, 1, 2, …, n – 1, 

where n is the number of elements in X. 

Hamming Window 

If y represents the output sequence Windowed X, the Hamming Window obtains the 
elements of y from 

yi = xi[0.54 − 0.46 cos w] 

for i = 0, 1, 2, …, n – 1, 

where n is the number of elements in the input sequence X. 

Blackman-Harris Window 

If y represents the output sequence Windowed X, the Blackman-Harris Window 
obtains the elements of y using the following formula: 

yi = xi[0.42323 − 0.49755cos w + 0.07922 cos 2w] 

for i = 0, 1, 2, … , n–1 

where n is the number of elements in X and 𝑤 =
2𝜋𝑖

𝑛
. 

Exact Blackman Window 
If y represents the output sequence Windowed X, the Exact Blackman Window obtains 
the elements of y using the following formula: 

yi = xi [
7938

18608
−

9240

18608
cos w +

1430

18608
cos 2w] 

for i = 0, 1, 2, … , n–1 

where n is the number of elements in X and 𝑤 =
2𝜋𝑖

𝑛
. 
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Blackman Window 
If y represents the output sequence Windowed X, the Blackman Window obtains the 
elements of y using the following formula: 

yi = xi[0.42 − 0.50cos w + 0.08 cos 2w] 

for i = 0, 1, 2, … , n–1 

where n is the number of elements in X and 𝑤 =
2𝜋𝑖

𝑛
. 

Flat Top Window 
If y represents the output sequence Windowed X, the Flat Top Window obtains the 
elements of y using the following formula: 

yi = xi[0.21557895
− 0.41663158cos w + 0.277263158 cos 2w
− 0.083578947 cos 3w + 0.006947368 cos 4w] 

for i = 0, 1, 2, … , n–1 

where n is the number of elements in X and 𝑤 =
2𝜋𝑖

𝑛
. 
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Appendix D – File Format 

Example files are partly reproduced below: 

Spectrum file (.spec/.pspec) 

ISI HES1000  

150914_125024.185 

Exp: 1.000000 

Littrow: 784.800000 

Laser: 785.000000 

Cal: 14.950000 

Window: 1 

Averaging: None: 1 

 

[data] 

784.800000 -9.734225 1367.544703 

784.971578 -6.949066 503.426336 

785.143232 -4.163908 30.107357 

785.314961 -1.378749 4.641915 

785.486764 1.406409 2.964024 

785.658643 4.191568 1.692935 

785.830598 6.976726 0.258375 

786.002627 9.761885 0.486264 

786.174732 12.547043 0.446257 

786.346912 15.332202 0.180656 

786.519168 18.117360 0.218201 

786.691499 20.902518 0.149626 

786.863905 23.687677 0.177486 

  

Header – this includes 
the date and time, 
configuration and 
calibration 
information plus the 
contents of the ‘Save 
Notes’ 

Time YYMMDD_hhmmss.ms 

Exposure in seconds 

Littrow wavelength 

Laser wavelength 

Calibration coeff 

Window (Apodising used) 

Averaging type & number 

Data section 

Contains three columns each of data 

Wavelength (nm), wavenumber(cm-1), relative intensity/power 
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Image File (.hes) & Dark Image file (.dark) 

ISI HES1000  

150914_125024.185 

Exp: 1.000000 

Littrow: 784.800000 

Laser: 785.000000 

Cal: 14.950000 

Window: 1 

Averaging: None: 1 

 

[data] 

531 530 532 532 530 531 531 532 531 532 532 532 
532 531 531 533 533 531 531 534 533 532 531 533 
532 533 533 533 533 532 534 533 533 533 534 534 
533 533 533 533 533 534 535 533 535 533 534 534 
533 535 534 534 534 535 535 534 534 537 536 537 
537 537 538 539 537 540 541 543 544 545 543 546 
547 547 547 551 551 554 556 560 559 563 561 562 
567 569 571 573 574 574 580 580 586 589 590 591 
594 600 600 600 604 603 601 610 609 617 609 616 
616 619 619 618 616 622 627 628 630 633 639 636 
639 643 654 660 655 658 655 664 660 669 676 668 
671 681 674 675 687 695 687 693 700 699 696 699 

…. 

 

Header – this includes 
the date and time, 
configuration and 
calibration 
information plus the 
contents of the ‘Save 
Notes’ 

Data section 

This will be multiple columns corresponding to the rows 
and columns of the pixels in the detector 

Time YYMMDD_hhmmss.ms 

Exposure in seconds 

Littrow wavelength 

Laser wavelength 

Calibration coeff 

Window (Apodising used) 

Averaging type & number 


